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10.1 ΑΝΣΙΚΔΙΜΔΝΟ 
 

Η κέηξεζε ηνπ πάρνπο κηαο ηξίραο από δηαθνξεηηθνύο δσηθνύο νξγαληζκνύο 

κε ηε βνήζεηα ηνπ θαηλνκέλνπ ηεο πεξίζιαζεο  

 

10.2 ΜΔΘΟΓΟ   

 

Φσηίδνπκε κηα ηξίρα κε κηα ζπζθεπή laser κε απνηέιεζκα, ζε κηα νζόλε 

παξαηήξεζεο, λα εκθαλίδεηαη δηακόξθσκα πεξίζιαζεο. Μεηξώληαο ηηο 

απνζηάζεηο ζθνηεηλώλ θξνζζώλ από ηνλ θεληξηθό θσηεηλό θξνζζό 

κπνξνύκε λα πξνζδηνξίζνπκε ην πάρνο ηεο ηξίραο. Γηα ην ζθνπό απηό ζα 

γίλεη ρξήζε πξνγξάκκαηνο ςεθηαθήο επεμεξγαζίαο εηθόλαο. 

 

10.3 ΘΔΩΡΙΑ  

 

Τν θαηλόκελν ηεο πεξίζιαζεο είλαη καδί κε απηό ηεο ζπκβνιήο 

ραξαθηεξηζηηθό ησλ θπκάησλ. Παξαηεξείηαη θάζε θνξά πνπ ην θύκα 

ζπλαληά θάπνην άλνηγκα ή εκπόδην κε δηαζηάζεηο ζπγθξίζηκεο κε ην κήθνο 

ηνπ θύκαηνο. Αλ ζεσξήζνπκε όηη έρνπκε κηα νπή πάλσ ζε έλα πέηαζκα ζην 

νπνίν πξνζπίπηεη θάπνην θύκα ηόηε αλάινγα κε ηηο ζρέζε ηνπ εύξνπο ηεο 

νπήο κε ην κήθνο ηεο θύκαλζεο κπνξνύκε λα παξαηεξήζνπκε θάηη από ηα 

αθόινπζα. 

 

 

Σηελ πεξίπησζε πνπ ην εύξνο (α) ηεο νπήο είλαη 

πνιύ κεγαιύηεξν από ην κήθνο ηνπ θύκαηνο (λ) 

δελ ζα ζπκβεί πεξίζιαζε θαη ζην πίζσ κέξνο ηνπ 

πεηάζκαηνο ζα εκθαληζηεί κηα ζαθήο ζθηά 

(πεξηνρή πνπ δελ θζάλεη ην θύκα) πνπ ην ζρήκα 

ηεο ζα αληαπνθξίλεηαη ζην ζρήκα ηεο νπήο. Σηελ 

πεξίπησζε πνπ ζην πέηαζκα πξνζέπηπηαλ 

ζσκαηίδηα αληί γηα θάπνην θύκα, ζα είρακε 

αθξηβώο ην ίδην θαηλόκελν κε βάζε ηελ 

επζύγξακκε δηάδνζή ηνπο. 

  

  



 

Καζώο ην εύξνο (α) ηεο νπήο πιεζηάδεη ην κήθνο 

ηνπ θύκαηνο (λ) ε ζθηά παύεη λα είλαη ζαθήο θαη 

λα θαζνξίδεηαη από ηελ νπή ελώ ην θύκα θζάλεη 

ζε πεξηνρέο πνπ πξνεγνπκέλσο δελ έθζαλε.  

  

 

Καζώο ην εύξνο (α) ηεο νπήο κεηώλεηαη αθόκα 

πεξηζζόηεξν θαη γίλεηαη ίδην πεξίπνπ κε ην κήθνο 

ηνπ θύκαηνο (λ) ην «άλνηγκα» ηνπ θύκαηνο 

γίλεηαη αθόκα κεγαιύηεξν. 

  

 

Όηαλ ην εύξνο (α) ηεο νπήο γίλεη πνιύ κηθξόηεξν 

από ην κήθνο ηνπ θύκαηνο (λ) ηόηε ην θύκα 

απιώλεηαη ζε όιε ηελ πεξηνρή πίζσ από ην 

πέηαζκα. Αμίδεη λα ζεκεησζεί όηη ζηελ 

πεξίπησζε πνπ ην πείξακα δηεμάγνληαλ κε 

ζσκαηίδηα ζα εκθαλίδνληαλ ζσκαηίδηα κόλν 

αθξηβώο πίζσ από ηε ζρηζκή, αλεμάξηεηα από ην 

εύξνο ηεο. 

  

Αλ θαη ε πεξίζιαζε αθνξά όια ηα είδε ησλ θπκάησλ ζηε ζπλέρεηα ζα 

αζρνιεζνύκε απνθιεηζηηθά κε ηελ πεξίζιαζε ηνπ θσηόο. Έλαο ηξόπνο γηα 

λα εμεγεζεί ην θαηλόκελν ηεο πεξίζιαζεο είλαη ε αξρή Huygens. Σύκθσλα 

κε απηή, θάζε ζεκείν ηεο ζρηζκήο ζηελ νπνία θζάλεη ην θσο ιεηηνπξγεί σο 

πεγή θπκάησλ πνπ δηαδίδνληαη πίζσ από ην πέηαζκα. Από ηε ζπκβνιή 

απηώλ ησλ θπκάησλ εκθαλίδνληαη κέγηζηα θαη ειάρηζηα θσηόο (εληζρπηηθή 

θαη απνζβεζηηθή ζπκβνιή) κε ζπλέπεηα λα ππάξρεη, εθηόο ηεο 

παξαηεξνύκελεο αιιαγήο πνξείαο (αλνίγκαηνο ηεο δέζκεο) ηνπ θσηόο, θαη 

αλαθαηαλνκή ηεο έληαζήο ηνπ ην ιεγόκελν δηακόξθσκα πεξίζιαζεο. Αο 
  

  

  



ππνζέζνπκε ινηπόλ όηη θσο κήθνπο θύκαηνο λ πνπ εθπέκπεηαη από έλα laser 

πξνζπίπηεη πάλσ ζε ζρηζκή εύξνπο α (ζπγθξίζηκε κε ην κήθνο θύκαηνο) 

πνπ βξίζθεηαη ζε πέηαζκα ην νπνίν απέρεη απόζηαζε L από κηα νζόλε 

παξαηήξεζεο όπσο θαίλεηαη ζην αθόινπζν ζρήκα. 

 
Σηελ πεξίπησζε πνπ ηα θύκαηα πνπ πξνζπίπηνπλ ζηε ζρηζκή είλαη 

επίπεδα (πεξίζιαζε Fraunhofer) απνδεηθλύεηαη όηη ε έληαζε ηεο 

αθηηλνβνιίαο πίζσ από ην πέηαζκα θαη ζε έλα ζεκείν πάλσ ζηελ νζόλε 

παξαηήξεζεο πνπ νξίδεηαη από ηε γσλία θ δίλεηαη από ηε ζρέζε: 

 

 ( )      [
   (   )

   
]

 

( ) 

 

όπνπ   
 

 
     ( ). Από ηελ εμίζσζε απηή κπνξνύκε λα πξνζδηνξίζνπκε 

ηελ έληαζε ηεο πεξηζιώκελεο αθηηλνβνιίαο ζε νπνηαδήπνηε γσλία θ ζε 

ζρέζε κε ηελ αξρηθή θαηεύζπλζε ηεο δέζκεο πνπ εθπέκπεη ην laser. 

Μπνξνύκε πνιύ εύθνια λα ζπζρεηίζνπκε ην sinθ κε ηελ απόζηαζε y όπσο 

κεηξηέηαη από ην θέληξν ηεο νζόλεο παξαηήξεζεο θαη θαηά κήθνο ηεο κε ηε 

ζρέζε: 

 

   ( )  
 

√     
 ( ). 

 

 Σην αθόινπζν ζρήκα θαίλεηαη ε γξαθηθή παξάζηαζε ηεο έληαζεο ζε 

ζπλάξηεζε κε ηε γσλία θ (άξα θαη κε ηελ απόζηαζε y) 

 

Οθόνη παρατήρηςησ 

α laser 

L 

θ 

Πζταςμα με ςχιςμή 

y 



 
 

 Από ηε γξαθηθή παξάζηαζε παξαηεξνύκε όηη ζηελ νζόλε 

εκθαλίδεηαη έλα θεληξηθό θύξην κέγηζην πςειήο έληαζεο αθξηβώο απέλαληη 

από ην laser, πνιιά αζζελή δεπηεξεύνληα κέγηζηα εθαηέξσζελ ηνπ 

θεληξηθνύ κέγηζηνπ πνπ θαζώο απμάλεηαη ε γσλία θ (ή ε απόζηαζε y από ην 

θέληξν ηεο νζόλεο) κεηώλνληαη θαη κεηαμύ απηώλ ησλ κεγίζησλ ππάξρνπλ 

ζεκεία ειάρηζηεο (κεδεληθήο) έληαζεο (ζεκεία απόζβεζεο). Απνδεηθλύεηαη 

όηη απηά ηα ειάρηζηα πξνθύπηνπλ από ηε ζρέζε: 

 

     ( )                    ( ) 
 

όπνπ ην m νξίδεη ηελ ηάμε ηνπ ειαρίζηνπ. 

 Αληηθαζηζηώληαο ζηελ εμίζσζε (3) ηελ (2) εύθνια πξνθύπηεη όηη 

  
 

√     
      θαη αλ ππνζέζνπκε, όπσο ζπλήζσο ζπκβαίλεη, όηη     

ηόηε ε ηειεπηαία ζρέζε παίξλεη ηε κνξθή: 

 

  
 

 
    

   
⇒     

   

  
 

 

απ' όπνπ κπνξνύκε λα ππνινγίζνπκε ην εύξνο ηεο ζρηζκήο α εθόζνλ 

γλσξίδνπκε ην κήθνο θύκαηνο ηνπ θσηόο λ, ηελ απόζηαζε ζρηζκήο νζόλεο 

παξαηήξεζεο L θαη ηε ζέζε πνπ εκθαλίδεηαη ην πξώην y1 ή γεληθόηεξα 

θάπνην από ηα ειάρηζηα. 

Οθόνη παρατήρηςησ 

laser α 

Πζταςμα με ςχιςμή 

Κεντρικό μζγιςτο 

Δευτερεφοντα 
μζγιςτα 

Σημεία απόςβεςησ 
(μηδενικήσ ζνταςησ) 



 Τν ίδην αθξηβώο θαηλόκελν εκθαλίδεηαη θαη ζηελ πεξίπησζε πνπ ην 

θσο πξνζπίπηεη ζε θάπνην εκπόδην, αξθεί απηό λα έρεη ζπγθξίζηκεο 

δηαζηάζεηο κε ην κήθνο θύκαηνο ηνπ θσηόο. Μάιηζηα θαη ζηελ πεξίπησζε 

απηή ηζρύνπλ νη ίδηεο εμηζώζεηο πνπ αλαθέξζεθαλ πξνεγνπκέλσο γηα ηελ 

πεξίπησζε πεξίζιαζεο από ζρηζκή. 

 

Η αλάιπζε κηαο εηθόλαο πεξίζιαζεο είλαη πην εύθνιε θαη αθξηβήο 

ρξεζηκνπνηώληαο κηα ςεθηαθή εηθόλα ηεο. Μία ςεθηαθή εηθόλα έρεη ηελ 

κνξθή ςεθηδσηνύ θαη απνηειείηαη από εηθνλνζηνηρεία (pixel). Τν 

εηθνλνζηνηρείν είλαη, απιά, κηα ςεθίδα ηνπ ςεθηδσηνύ απηνύ θαη, σο εθ 

ηνύηνπ, ζεσξείηαη σο ην κηθξόηεξν πιήξεο δείγκα κηαο εηθόλαο. Σηελ νζόλε 

ελόο ππνινγηζηή νη εηθόλεο αλαπαξηζηώληαη κε "ππνδηαίξεζε" ηεο νζόλεο 

ζε έλα δηζδηάζηαην πίλαθα κε ζηήιεο θαη γξακκέο. Κάζε "θειί" ζε έλα 

ηέηνην πίλαθα είλαη έλα εηθνλνζηνηρείν. Ο αξηζκόο ησλ ππνδηαηξέζεσλ είλαη 

επαξθώο κεγάινο, ηόζν ώζηε ην αλζξώπηλν κάηη λα κε κπνξεί λα δηαθξίλεη 

ην έλα εηθνλνζηνηρείν από ην άιιν θαη λα βιέπεη ηελ εηθόλα εληαία. 

Ο αξηζκόο εηθνλνζηνηρείσλ ζε κηα εηθόλα θαιείηαη κεξηθέο θνξέο 

ανάλςζη ηεο εηθόλαο. Οη ηηκέο αλάιπζεο ζε εηθνλνζηνηρεία κπνξνύλ λα 

εθθξαζηνύλ: α) είηε σο εληαίνο αξηζκόο, όπσο ζε κηα ςεθηαθή θσηνγξαθηθή 

κεραλή, π.ρ. «3 megapixel». Απηό ζεκαίλεη όηη ε κεραλή έρεη νλνκαζηηθά 

ηξία εθαηνκκύξηα εηθνλνζηνηρεία, ή β) σο δεύγνο αξηζκώλ, όπσο, π.ρ. εηθόλα 

"640 επί 480". Η έθθξαζε απηή ζεκαίλεη όηη ε εηθόλα έρεη 640 

εηθνλνζηνηρεία θαηά κήθνο θαη 480 θαζ' ύςνο θαη επνκέλσο ζπλνιηθό 

αξηζκό 640 x 480 = 307.200 εηθνλνζηνηρεία (ή 0,3 megapixels). 

Κάζε εηθνλνζηνηρείν ζε κηα κνλνρξσκαηηθή εηθόλα έρεη κία ηηκή 

θσηεηλόηεηαο (έληαζεο θσηόο) Θ.   Η ηηκή 0 ζπλήζσο αληηπξνζσπεύεη ην 

καύξν θαη ε κέγηζηε ηηκή αληηπξνζσπεύεη ην ιεπθό. Σε κηα έγρξσκε εηθόλα, 

θάζε εηθνλνζηνηρείν αληηπξνζσπεύεηαη ζπλήζσο από ηηκέο γηα ην θόθθηλν, 

πξάζηλν, θαη κπιε (RGB). 

Γηα ηελ επθξηλή απεηθόληζε ηνπ δηακνξθώκαηνο πεξίζιαζεο 

απαηηείηαη ηθαλή αληίζεζε εηθόλαο (contrast) πνπ νξίδεηαη σο   

 
     

  
     

όπνπ Θπ είλαη ε αθηηλνβνιία ππνβάζξνπ θαη Θδ είλαη ε αθηηλνβνιία δείγκαηνο. 

 



10.4   ΤΚΔΤΔ 

 

 
 

ΠΡΟΟΥΗ !! : 
ΓΔΝ ΑΦΗΝΟΤΜΔ ΠΟΣΔ ΝΑ ΔΙΔΛΘΔΙ ΑΠΔΤΘΔΙΑ 

ΣΑ ΜΑΣΙΑ ΜΑ Η ΓΔΜΗ ΦΩΣΟ LASER !   

 

ΓΔΝ ΜΔΣΑΚΙΝΟΤΜΔ ΣΗΝ ΠΗΓΗ LASER ΑΠΟ ΣΟΝ 

ΟΡΘΟΣΑΣΗ !  

 

ΓΔΝ ΠΑΡΔΜΒΑΛΟΤΜΔ ΑΛΛΑ ΑΝΣΙΚΔΙΜΔΝΑ ΔΚΣΟ 

ΑΠΟ ΣΗΝ ΣΡΙΥΑ ΣΗΝ ΓΔΜΗ ! 

 

10.5  ΔΚΣΔΛΔΗ ΑΚΗH   
 

Α. Καηαγπαθή εικόναρ πεπίθλαζηρ 

 

1) Δεκηνπξγείζηε έλα θαηλνύξγην θάθειν «ΟmadaΦ» (κε ιαηηληθνύο 

ραξαθηήξεο) γηα ηελ νκάδα ζαο Φ όπνπ ζα ηνπνζεηήζεηε όια ηα αξρεία ζαο 

ςεθηαθώλ εηθόλσλ.  

 

2) Αλνίμηε κε δηπιό θιηθ ην πξόγξακκα Paint («Ζσγξαθηθή»), επηιέμηε 

File>From scanner or camera πνπ ζαο δίλεη εηθόλα από ηελ θάκεξα. Αλνίμηε 



ηελ ιάκπα (κε ηνλ δηαθόπηε ζην θαιώδην) ηεο θάκεξαο θαη ξπζκίζηε ηνλ 

θσηηζκό ώζηε λα θσηηζηεί ε νζόλε παξαηήξεζεο θαη λα είλαη νξαηή ε 

θιίκαθα mm. 

 

3) Καηαγξάςηε (παηώληαο ην Capture>Get picture) θαη απνζεθεύζηε ηελ 

εηθόλα 1 ζηνλ θάθειν ζαο. Σβήζηε ηελ ιάκπα γηα λα ζπζθνηίζεηε ηελ νζόλε 

παξαηήξεζεο. 

 

4) Σε θάζε νκάδα ζα δνζεί δείγκα ηξίραο δηαθνξεηηθνύ δώνπ (θαη ζπλεπώο 

πάρνπο). Καηαγξάςηε ηνλ αξηζκό ηνπ δείγκαηνο   ……. 

 

5) Τνπνζεηείζηε κε βνήζεηα νξζνζηάηε ηελ ηελησκέλε ηξίρα ζηελ δηαδξνκή 

ηεο αθηίλαο θαη κεηαθηλήζηε ηελ αξγά κέρξη λα ηελ δείηε λα θσηίδεηαη θαη 

λα εκθαληζηνύλ νη θξνζζνί πεξίζιαζεο ζηελ εηθόλα. Αλ δελ είλαη ε ηξίρα 

πξνζαξκνζκέλε ζε πιαίζην, ρξεζηκνπνηήζηε έλα θιηπ ζαλ βαξίδην γηα λα 

ηεληώζηε ηελ ηξίρα θαηαθόξπθα. 

 

6) Καηαγξάςηε θαη απνζεθεύζηε ηελ εηθόλα 2. 

 

7) Μεηξήζηε ηελ απόζηαζε (θαη ην ζθάικα) ηεο νζόλεο παξαηήξεζεο από 

ηελ ηξίρα.  …..................... 

Ζεηήζηε από ηνλ ππεύζπλν ηεο άζθεζεο λα ζαο πεη πνην είλαη ην κήθνο 

θύκαηνο ηνπ θσηόο από ην laser.     ………. 

 

Β. Ανάλςζη εικόναρ με ηo ππόγπαμμα επεξεπγαζίαρ εικόναρ  ImageJ. 

 

1) Μεηαθέξεηε ηα αξρεία ζηνλ ππνινγηζηή ηεο νκάδαο ζαο κε ζηηθάθη. 

 

2) Αλνίμηε ην πξόγξακκα  ImageJ  θαη επηιέμηε, από ηον δικό ζαρ θάκελο, 

ην αξρείν κε ηελ θσηηζκέλε θιίκαθα κηιηκεηξέ  (εηθόλα 1) κε ηελ εληνιή 

«File>Open». Εμνηθεησζείηε κε βαζηθέο εληνιέο επηζθόπεζεο ηεο εηθόλαο 

ρξεζηκνπνηώληαο ηα θνπκπηά ζην πνληίθη.  

 

3) Παξαηεξήζηε όηη νξηζκέλεο πιεξνθνξίεο ζρεηηθά κε ηελ εηθόλα 

εκθαλίδνληαη ζηελ θνξπθή ηνπ παξαζύξνπ ηεο εηθόλαο: Τν κέγεζνο ηεο 

εηθόλαο ζε εηθνλνζηνηρεία (pixel), ν ηύπνο θαη ην κέγεζνο ηνπ αξρείνπ 

εηθόλαο ζηε κλήκε ηνπ ππνινγηζηή.  

 

4) Επηιέμηε ην εξγαιείν κεγεζπληηθνύ θαθνύ ζηε γξακκή εξγαιείσλ θαη 

θάληε θιηθ ζηελ εηθόλα. Τν αξηζηεξό θιηθ θάλεη κεγέζπλζε (zoom-in), ελώ 



ην δεμί θιηθ θάλεη ζκίθξπλζε (zoom-out). Επίζεο κπνξείηε λα 

ρξεζηκνπνηήζεηε ηα πιήθηξα "+" θαη "-" ζην πιεθηξνιόγην γηα λα θάλεηε 

δνπκ. 

 

5) Κάλεηε κεγέζπλζε ώζηε λα εκθαληζηεί ν δείθηεο ζέζεο. Παξαηεξήζηε 

ηνλ δείθηε ζέζεο ζηελ επάλσ αξηζηεξή γσλία, όηαλ ε εηθόλα είλαη 

κεγαιύηεξε από ην παξάζπξν. Επηιέμηε ηνλ θέξζνξα (scrolling tool)  ζηε 

γξακκή εξγαιείσλ. Κάληε θιηθ ζηελ εηθόλα θαη ρσξίο λα απειεπζεξώζεηε 

ην θνπκπί κεηαθηλήζηε ην πνληίθη. Μεηαβείηε ζηελ θάησ δεμηά γσλία ηεο 

εηθόλαο.  

 

6) Επηιέμηε μαλά ην εξγαιείν κεγεζπληηθνύ θαθνύ. Κάλεηε κεγέζπλζε ώζηε 

λα εκθαληζηεί ν δείθηεο ζέζεο. Μπνξείηε λα ζύξεηε ηελ εηθόλα θξαηώληαο 

παηεκέλν ην πιήθηξν δηαζηήκαηνο αληί λα ρξεζηκνπνηήζεηε ηνλ θέξζνξα. 

Τν πιενλέθηεκα είλαη όηη έλα άιιν εξγαιείν κπνξεί λα είλαη ελεξγό 

ηαπηόρξνλα. Δνθηκάζηε λα κεηαθηλεζείηε ζηελ θάησ αξηζηεξή γσλία.  

 

7) Κάλεηε κεγέζπλζε ζην κέγηζην δνπκ θαη κεηαθηλήζηε ηνλ θέξζνξα πάλσ 

ζηελ εηθόλα. Ειέγμηε ηε γξακκή θαηάζηαζεο ηνπ παξαζύξνπ ηνπ θεληξηθνύ 

κελνύ ImageJ. Εκθαλίδεηαη ε ζέζε (ζπληεηαγκέλεο) ζε pixel θάησ από ηνλ 

θέξζνξα θαη ε θσηεηλόηεηα ηνπ. 

 

8) Δνθηκάζηε ηα δηάθνξα εξγαιεία επηινγήο γπαμμήρ. Φξεζηκνπνηήζηε ην 

εξγαιείν επζείαο γξακκήο γηα λα βξείηε πόζα εηθνλνζηνηρεία αληηζηνηρνύλ 

ζε 10 mm. Επηιέμηε Analyze>Measure γηα λα κεηξήζεηε απνζηάζεηο κε 

αθξίβεηα. Πνην ην ζθάικα ζε απηέο ηηο κεηξήζεηο;   ………………… 

 

9) Αλνίμηε ην αξρείν κε ηελ ζπζθνηηζκέλε εηθόλα πεξίζιαζεο (εηθόλα 2). 

Παξαηεξείζηε ην δηακόξθσκα πεξίζιαζεο θαη εληνπίζηε ηελ ζέζε ησλ 

θξνζζώλ.  Με ηελ εληνιή Analyze>Set Scale αληηζηνηρήζηε ηα 10 mm ζηνλ 

αξηζκό εηθνλνζηνηρείσλ πνπ βξήθαηε. 

 

10) Μπνξείηε λα ρξεζηκνπνηήζεηε ηα εξγαιεία επηινγήο γξακκήο γηα λα 

δεκηνπξγήζεηε πποθίλ. Μηα γξαθηθή παξάζηαζε ηύπνπ πξνθίι δίλεη ηηο 

ηηκέο έληαζεο θσηόο θαηά κήθνο ηεο γξακκήο. Επηιέμηε κηα γξακκή θαηά 

κήθνο ηνπ δηακνξθώκαηνο πεξίζιαζεο θαη, ζηε ζπλέρεηα, επηιέμηε Analyze 

> Plot Profile. Φξεζηκνπνηήζηε ην πξνθίι γηα λα εθηηκήζεηε ηελ απόζηαζε 

ηνπ 1
νπ

 ζθνηεηλνύ θξνζζνύ από ην θέληξν ηεο αθηίλαο. (Tν δηάγξακκα 

πξνθίι είλαη θαη απηό κηα εηθόλα, άξα κπνξείηε λα ρξεζηκνπνηήζεηε ηα 



εξγαιεία ηνπ ImageJ πάλσ ζε απηό). Πνην είλαη ην ζθάικα ζηελ κέηξεζε 

απηή; …………………………………… 

 

11) Σώζηε θάπνηα εηθόλα ηνπ πξνθίι γηα ηελ εξγαζία ζαο (παηήζηε 

PrintScreen  θαη κεηά ζην πξόγξακκα Ζσγξαθηθή (Paint), παηήζηε paste θαη 

ζώζηε ην αξρείν) 

 

12) Αληηγξάςηε ζε ζηηθάθη όηη αξρεία ρξεηάδεζηε γηα ηελ εξγαζία ζαο. 

  

13) Σηελ εξγαζία ζαο θάλεηε κηα κηθξή εηζαγσγή, πεξηγξαθή ηνπ 

πεηξάκαηνο θαη ησλ απνηειεζκάησλ ζαο, ππνινγίζηε ην κέγεζνο  ηνπ  

πάρνπο ηεο ηξίραο (θαη ην ηειηθό ζθάικα). Σπκπεξηιάβεηε ηελ εηθόλα 

πξνθίι ηεο έληαζεο. Επίζεο απαληήζηε ηηο παξαθάησ εξσηήζεηο. 

 

 

10.6 ΔΡΩΣΗΔΙ 

 
1) Πνηα πνζόηεηα βειηηώλεηαη όηαλ θάλνπκε ζπζθόηηζε ζην εζσηεξηθό ηεο 

ζπζθεπήο γηα ηελ ιήςε θσηνγξαθίαο; Γηαηί; 

 

2) Υπάξρεη θάπνην πιενλέθηεκα ζην λα ρξεζηκνπνηήζεηε ην πξνθίι αληί λα 

κεηξήζεηε απεπζείαο ηελ απόζηαζε ηνπ 1
νπ

 ζθνηεηλνύ θξνζζνύ ζηελ αξρηθή 

εηθόλα;    

 

3) Mε ηη αθξίβεηα ζα κπνξνύζαηε λα κεηξήζεηε ην πάρνο ηεο ηξίραο κε ην 

δηαζέζηκν κηθξόκεηξν; Εθηόο από ηελ αθξίβεηα ηη άιιν πξόβιεκα ζα είρε ε 

ρξήζε κηθξνκέηξνπ ζηελ ηξίρα; 
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